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In the introduction to this book, we discussed the design goals for Microsoft Power 
View and explained how Power View allows users to design and build their own 
reports in real time, bypassing the lengthy process of designing reports and having 

the IT department build them. We also discussed the fact that Power View provides a 
simple interface for building reports so users can start building reports soon after starting 
up Power View.

In this chapter, you’ll first learn how Microsoft business intelligence (BI) tools have 
evolved, culminating in the development and release of Microsoft Power View. Then, you’ll 
launch Power View and get a tour of the Power View user interface. Finally, this chapter 
introduces you to the sample data that is used in the examples throughout the book.

The Evolution of Microsoft Business Intelligence
Before we get into the details of Microsoft Power View, let’s take a look at how 
Microsoft business intelligence has evolved over the years. This background should give 
you a better understanding of how Power View works. It can also provide insight into 
how Power View is intended to be used.

In the “old days” of data warehousing and business intelligence, data marts and 
data warehouses were created using a top-down approach. Business users had to work 
through the IT department by following a traditional application design methodology. 
The process started with design meetings that took place over a period of weeks, months, 
or even years depending on the size of the project.

These design meetings would be attended by IT employees and business users in 
order to accomplish the following:

Determine and document the reporting and analysis requirements of the users▶▶

Identify the sources of data that would be used for making business decisions▶▶

Design processes to import data from these data sources▶▶

Plan out the database structure for the data warehouse▶▶

Design the reports and/or applications that would be used to analyze the data▶▶

Estimate the effort and cost to build the solution▶▶

Once the design was complete and management had approved the budget and 
timeline for the project, the IT department would build the data warehouse according 
to the design. Unfortunately, most data warehouse projects did not (and many still do 
not) complete within the budgeted time or cost. In addition, the users—for whom the 
project was originally started—did not have the ability to actually analyze any data until 
months, or oftentimes years, after the project was started.
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There are several consequences to approaching BI projects in this manner. First, the 
information needs of the users are likely to have changed from the start of the project 
to the time the first analysis is delivered. The data warehouse is already obsolete by 
the time it becomes available for use! Second, users often find that the reports and 
applications do not provide all of the necessary information to make business decisions. 
Reports designed on paper look very different once they are loaded with actual data. 
Many times these reports lead to further business questions and users discover that 
the reports were not designed to answer these new questions. Imagine management’s 
perspective, spending thousands or millions of dollars on a project only to find out that 
core business decisions cannot be made using the tools created! I wouldn’t want to be 
the person delivering that news!

Microsoft’s approach to the BI methodology has evolved to be more user-centric. 
The users are the ones who know their data the best and know what they want to learn 
from that data. Instead of having the users sit down with the IT department to build 
a solution on paper, why not give the users access to the data along with easy-to-use 
analysis tools? That is the approach Microsoft has chosen to pursue, as evidenced by 
Power View and the Tabular BI Semantic Model (BISM). 

PowerPivot
Many business users are very comfortable working with data in Excel. The main 
problem users experience with Excel is the limited number of rows allowed in a 
workbook and the poor performance that results when working with large amounts 
of data. If users could effectively use the data analysis tools in Excel with a workbook 
containing millions of rows of data, they could fulfill many of their data analysis needs. 
This was the inspiration for PowerPivot.

PowerPivot is a data analysis add-on for Microsoft Excel 2010 that allows large 
amounts of data to be collected, aggregated, and analyzed in one workbook. PowerPivot 
workbooks use a powerful data engine to quickly query a large volume of data. Using 
PowerPivot, many business intelligence questions can be answered efficiently and 
responsively directly within Excel.

The data to be analyzed may come from a variety of sources. The user imports this 
data into the PowerPivot workbook. Once the data is loaded, the user can utilize tools 
such as PivotTables and PivotCharts to calculate totals and find trends in the data. 
Figure 1-1 shows a sample PowerPivot analysis. Very powerful!

PowerPivot allows business intelligence to be more of an evolutionary process than 
a discreet project—providing a return on investment (ROI) almost immediately. Users 
can make business decisions based on results in PowerPivot in very short order. The 
need for a huge business intelligence project that does not provide deliverables for 
months is gone!
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In addition, Microsoft provides a way for analysis work done by an individual user in 
PowerPivot to be shared at various levels throughout an enterprise. PowerPivot has two 
editions—PowerPivot for Excel, which works within Excel on a user’s workstation, and 
PowerPivot for SharePoint. Using PowerPivot for SharePoint, analysis can be shared by 
a number of users in a work group or department.

For example, say Bill in accounting has analyzed the general ledger data and created 
some useful charts illustrating trends in gross profit. Others in his department have seen 
his PowerPivot workbook and would like to use those charts to create their own charts 
using the same data. To meet their needs, Bill publishes the PowerPivot workbook 
to a document library within the accounting department’s Microsoft SharePoint site. 
The entire department can then use and enhance the workbook. The workbook has 
gone from being an individual tool to an important departmental resource. It has been 
escalated to the next level of use without the intervention of the IT department.

To make the leap from departmental resource to enterprise-wide tool, we leverage 
another Microsoft product, SQL Server Analysis Services.

Analysis Services and the BI Semantic Model
Microsoft SQL Server Analysis Services has provided the support and capabilities for 
corporate-level business intelligence for over ten years. Analysis Services efficiently 
delivers large amounts of aggregate data to many corporate users for use in reports and 
interactive tools. It accomplishes this feat by using objects called cubes.

Figure 1-1 The output of a PowerPivot workbook

01-ch01.indd   6 5/10/12   3:46:49 PM



SQL_2008 / Visualizing Data with Microsoft® Power View / Larson et al. / 178082-3 / Chapter 1

 C h a p t e r  1 :  G e t t i n g  S t a r t e d  7

Cubes are loaded with aggregates of numeric quantities such as sales figures or 
inventory amounts. These aggregations are calculated when the data is loaded into the 
cube. The aggregates don’t need to be calculated when the user queries the data. As a 
result, totals can be retrieved from Analysis Services cubes very quickly.

For example, if Ashley needs a report listing the sales for the company, totaled by 
department and year, Analysis Services will have already calculated these values in the 
cube. Instead of having to sum up the thousands of individual sales and group the totals 
by department and year, Ashley’s report can retrieve the sales figures already totaled by 
department and year from the cube in Analysis Services.

Analysis Services cubes and their supporting data are known as Multidimensional 
BI Semantic Models. These models are not built by the users of the data. Business 
intelligence professionals within the IT department work with the users to design and 
build these models. As a result, the method of creating Multidimensional BI Semantic 
Models resembles the traditional method for building business intelligence solutions 
more closely than it resembles the new, user-centric method.

To remedy this situation, Microsoft has enhanced Analysis Services to host a new 
type of structure known as a Tabular BI Semantic Model. As the name implies, the 
Tabular BI Semantic Model manages data in a tabular format similar to the way Excel 
and, more importantly, PowerPivot manage data. This model provides the architecture 
and optimization for a large number of users to access data in a format identical to 
the data storage method used by PowerPivot. Having Analysis Services host Tabular 
BI Semantic Models fills the need for the top level of scalability in this user-centric 
approach to business intelligence.

Tabular BI Semantic Models are built using a tool called SQL Server Data Tools 
that comes with Microsoft SQL Server. With this tool, a model can be created from 
scratch or a PowerPivot workbook can be imported to create the basis for the model. 
Once the model is complete, it is deployed to Analysis Services, which provides the 
infrastructure to make the model available to reporting tools and other client software.

The user-centric approach to business intelligence now functions in this manner:

A business decision maker connects to existing data sources and loads the data ▶▶

into PowerPivot for Excel in order to begin analysis.
As time passes, the decision maker determines the workbook would be beneficial ▶▶

to the entire department and deploys the PowerPivot workbook to a Microsoft 
SharePoint document library used by the department. The members of the 
department can use and enhance the workbook.
Over time, the department members enhance the PowerPivot workbook, adding ▶▶

calculations and charts that would be useful to the entire company. The IT department 
imports the PowerPivot workbook from Microsoft SharePoint and uses it as the 
foundation for a Tabular BI Semantic Model. The IT department deploys the model 
to Analysis Services to make the data available to the entire company.
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Our users now need a way to analyze and explore data in a Tabular BI Semantic 
Model deployed to Analysis Services. Power View fulfills that role.

Launching Power View
Now that you’re familiar with a little of the history of Microsoft business intelligence, 
you’re ready to get back to learning about Power View. In fact, it’s time to start up 
Power View and take a look around.

Power View and Microsoft SharePoint
Microsoft Power View is not a stand-alone application like Microsoft Word or Microsoft 
Excel. You do not install Power View onto your PC to begin building and using reports. 
Much of the functionality of Power View depends upon the features built into Microsoft 
SharePoint and, as a result, Power View can be launched only from a SharePoint 
environment.

SharePoint Server was introduced by Microsoft in 2001 and was originally used as 
a document management and search tool. It provided the ability to upload documents 
and track document versions as they were being authored. Microsoft SharePoint Server 
also allowed users to find documents easily by searching both the names and the 
contents of the documents.

Microsoft SharePoint has changed a great deal since the original version in 2001. 
SharePoint is now used as a powerful tool for sharing information internally between 
employees and externally with customers and vendors. With Microsoft SharePoint 2010, 
companies can host employee blogs, share project and team information using many 
different site templates, provide business intelligence dashboards, build custom applications, 
and provide many social networking features to their employees and customers.

As a result, SharePoint is a natural fit for Power View. SharePoint is focused on 
collaboration and content sharing. Power View is a tool used to both visualize data and 
share it with others.

Required Software
In order to successfully create and run reports with Power View, certain software is required 
on your PC. Power View runs inside an Internet browser, but not all browsers will run the 
Power View interface. Power View will run in Internet Explorer 8 and Internet Explorer 9. 
Power View also runs in Firefox 4.

In addition to browser considerations, Microsoft Silverlight 5 also needs to be installed 
on your PC. Microsoft Silverlight provides a rich user experience in browser-based 
applications. It is Silverlight that makes possible many of the easy-to-use features in 
Power View.
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Power View Data Sources
Microsoft Power View reports do not work like other reporting engines that access 
data directly from databases. The data for Power View reports needs to be placed in 
the proper model. Power View reports are generated using a BI Semantic Model. That 
BI Semantic Model can be a PowerPivot workbook or a Tabular BI Semantic Model 
created using SQL Server Data Tools. Although Power View cannot access other 
data sources directly, many different data sources can be used to load data into these 
PowerPivot workbooks and Tabular BI Semantic Models.

Launching Power View Using a PowerPivot Workbook
Once a PowerPivot workbook has been built and loaded with data, the workbook can 
be deployed to Microsoft SharePoint, either in a PowerPivot gallery or in a standard 
document library. The workbook in the gallery or library can then be used as the data 
source for Power View reports.

Note

If you have access to a physical learning environment hosting the Pan-Geo Hospitality and Travel data created 
according to the steps in Appendix A or if you have created a virtual learning environment using the steps in 
Appendix B, then you can use the Learn By Doing steps here to try launching Power View for yourself. If you 
do not have a learning environment available, please view the indicated video to watch as these steps are 
completed by one of the authors. Use this same approach for the Learn By Doing exercises in the remainder of 
this chapter and throughout the book.

Learn By Doing: Opening Power View Using  
a PowerPivot Workbook Connection
In this Learn By Doing exercise, we are simply going to launch Power View from a 
PowerPivot workbook and then return to the SharePoint library.

Launching Power View Using a PowerPivot Workbook

1.  Open Internet Explorer and navigate to the home page of the SharePoint site 
hosting your learning environment.

2.  Click the PowerPivot Gallery link on the left side of the screen under Libraries, 
as shown in Figure 1-2.

Video 1-1
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3.  This PowerPivot Gallery screen shows the list of PowerPivot workbooks that have 
been uploaded to SharePoint. Locate the entry for “PGHT Tourism PowerPivot 
Model.” The upper-right corner of each PowerPivot gallery entry contains three 
icons, as shown in Figure 1-3. These icons appear faded, as if they were disabled, 
until you hover your mouse pointer over them. When you hover over the middle 
link, it displays a tooltip saying “Create Power View Report.” Click the middle 
icon of the “PGHT Tourism PowerPivot Model” entry to launch Power View.

4.  Microsoft Power View will open with the tables from the PowerPivot workbook 
listed on the right. Your screen should look similar to Figure 1-4.

5.  Click your browser’s Back button to return to the PowerPivot Gallery. If you 
made any changes to the Power View canvas, you will see a dialog box asking, 
“Are you sure you want to navigate away from this page?” If you see this dialog 
box, click OK.

6.  Click the browser’s Back button a second time to return to the SharePoint site.

Launching Power View Using  
a Tabular BI Semantic Model
Tabular BI Semantic Models are not loaded into SharePoint in the same way PowerPivot 
workbooks are. The models are hosted within SQL Server Analysis Services. As a result, 
Microsoft Power View needs to know the location of the Tabular BI Semantic Model in 

Figure 1-2 PowerPivot Gallery link

PowerPivot 
Gallery
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order to load data into the reports. The location of the Tabular BI Semantic Model on 
an Analysis Services server is identified in one of two ways: using a BI Semantic Model 
connection file or using a Reporting Services data source. Both the connection file and 
the data source are essentially small files that contain the name of the server and database 
that hosts the Tabular BI Semantic Model.

Note

BI Semantic Model connection files and Reporting Services data sources can also be used to point to PowerPivot 
workbooks that have been uploaded to SharePoint.

Learn By Doing: Opening Power View Using  
Tabular BI Semantic Model Connections
In this Learn By Doing exercise, we are simply going to launch Power View using a BI 
Semantic Model connection file, return to the SharePoint library, and then do the same 
thing using a Reporting Services data source.

Figure 1-3 Create Power View Report button for a PowerPivot Gallery entry
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Launching Power View Using a Tabular Model

 1. Open Internet Explorer and navigate to the SharePoint document library hosting 
your learning environment, if you are not already there.

 2. Hover your mouse over the PGHT Tourism item in the document library. A 
drop-down arrow appears.

 3. Click the drop-down arrow and select Create Power View Report from the drop-
down menu, as shown in Figure 1-5. Microsoft Power View opens, with the tables 
from the Tabular BI Semantic Model listed on the right.

 4. Click your browser’s Back button to return to the SharePoint site.
 5. Hover your mouse over the PGHT Tourism RS item. A drop-down arrow 

appears.
 6. Click the drop-down arrow and select Create Power View Report from the drop-

down menu. Power View opens once again.

Figure 1-4 Microsoft Power View main screen

Video 1-2
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Notice the same steps are performed whether you are loading Power View using a BI 
Semantic Model connection file or a Reporting Services data source.

tip

You can open Power View by simply clicking the BI Semantic Model connection file in the document library. 
This is not true for the Reporting Services data source. Clicking the Reporting Services data source opens the 
properties of the data source rather than opening Power View.

Microsoft Power View User Interface
When you open a Microsoft Office 2010 application such as Word to a new blank 
document, you see a fairly basic screen. There is lots of white space to start creating your 
document. The commands you may need are available on the various tabs of the ribbon.

Figure 1-5 Open Power View from a BI Semantic Model connection file.
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This is true of Microsoft Power View as well. The interface in Power View has lots 
of white space, a ribbon, and a few additional elements. Let’s take a tour through the 
important parts of the interface, as shown in Figure 1-6.

Canvas
One of the first things you notice when looking at the Power View interface is the lack 
of clutter. The screen is dominated by an empty section (except for a gray “watermark” 
in the center) with the heading “Click here to add a title.” This section is called the 
canvas and is used to hold the different data visualizations and navigation tools in the 
report. All of the tables, charts, slicers, and other elements will be placed on the canvas 
and will display selected data from the data sources.

Field List
The upper-right side of the screen below the ribbon is the Field List. The Field List 
holds the tables in the BI Semantic Model or the PowerPivot workbook, and the fields 
contained within the tables. The list of fields for each table can be viewed by clicking 
the triangle next to the table name.

Figure 1-6 The Microsoft Power View user interface

Field 
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Field Well
The Field Well resides in the bottom-right corner of the screen. It shows the fields 
selected from the model to appear on the canvas. It also provides access to properties 
and commands related to the object on the canvas that is currently selected. We use 
these properties and commands to control the appearance and behavior of the items on 
the canvas.

Filters Area
The Filters Area is used to restrict the amount of data displayed in a report. For example, 
we can use the Filters Area to restrict a report to show data only for the years 2005 to 
2010. The Filters Area can be hidden or displayed by clicking the Filters Area button 
on the ribbon. It can also be minimized using the “>” toggle at the top of the Filters Area.

View Area
The View Area is used to track several states or views of the report for analyzing the 
state of your data at various points in time or as other values change. It can also be used 
to present several states of your data when you are presenting that data to others.

Ribbon
The ribbon spans the top of the screen and holds the commands that can be performed 
on the entire report or a selected object in the report. The ribbon is broken out into 
separate tabs that categorize and organize the commands.

File Tab
The label for the File tab has a green background for emphasis. Clicking this tab activates 
a drop-down menu that holds several key commands, including Save and Print.

Home Tab
The Home tab, which is shown in Figure 1-6, holds the basic formatting commands. 
In addition, the Home tab holds a button to show or hide the Filters Area.

Additional Tabs
Other tabs will appear in the ribbon as needed. These tabs will often be highlighted in 
the ribbon to make them stand out from the standard tabs.

01-ch01.indd   15 5/10/12   3:46:50 PM



 1 6  V i s u a l i z i n g  D a t a  w i t h  M i c r o s o f t  P o w e r  V i e w

SQL_2008 / Visualizing Data with Microsoft® Power View / Larson et al. / 178082-3 / Chapter 1

Sample Data
This book guides you through the creation of a number of reports using Power View. 
To follow along, you need to have a set of data to work with. This data comes from our 
fictitious company, Pan-Geo Hospitality and Travel (PGHT). Throughout the book, 
you will be asked to assume different roles within the company and develop reports to 
meet the business needs of PGHT. If you do not have a learning environment available 
to you, you can watch the reports being developed in the accompanying videos.

A little bit about the company—PGHT owns and manages approximately 1,000 
hotels around the world. The company has been working hard to bring together hotel 
performance and financial data so the leadership team can make informed business 
decisions about hotels that are underperforming and may be in need of improvement. 
In addition, the company has imported tourism data from the United Nations World 
Tourism Organization (UNWTO). This data can be used to identify tourism trends 
around the world. PGHT is looking to combine the tourism data with the hotel data 
to find where it should be building new hotels and where it may need to close hotels.

While you are creating reports with the PGHT data, you have our permission to 
occasionally daydream about a vacation to Fiji or a getaway to South America!

Wrap-Up
Now that you have an introduction to Microsoft Power View, it’s time to get busy 
creating reports and taking advantage of all its great features. In the next chapter, 
you’ll create your first tabular reports and explore the different ways to customize the 
presentation of the tabular data. The “table” is set!
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